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INSTALLATION GUIDE

Prerequisites

e  Windows XP or Windows Vista.
e Any Visual Studio 2008 edition, with the exception of Visual Studio Express edition.

Notes about the installation process

Bundled with the installer archive come four files:

e  ProductLinesDSL.msi: the installer itself

o DSLElevatedinstaller.exe: a launcher that invokes the MSI installer.

e Readme.htm: contains a quick start guide and a link to the tool’s website. It’s shown automatically
after the installation process is complete.

e  Manual-en.pdf: this user’s manual.
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Figure 1: Contents of the installer package

A separate launcher is necessary because of the new User Account Control system present in Windows
Vista and later versions of Windows. Unfortunately, the MSI installer generated by DSL Tools does not
prompt for privilege elevation and therefore, there is no simple way to execute the installer when UAC
is on.

Because of this, DSLElevatedinstaller.exe is a simple wrapper that is responsible for prompting for
administrator credentials and launching the MSI installer as an elevated process.

INSTALLATION

e On Windows XP: launch any of the provided executables. An administrator account must be
used, or the installation will fail.

e On Windows Vista: launch DSLElevatedinstaller.exe. The installer will ask for administrator
credentials.

Once the installer is launched, it behaves the same as any other typical Windows installer. The only
point where user’s intervention is required is when he is required to enter an installation path.

For the sake of reference, the following screenshots show the complete development of the installation
process:

Table 1: Reference of installation steps
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UNINSTALLATION

The tool registers itself with Windows and it can be uninstalled in the usual way through the Windows
Control Panel.

The tool allows the creation and configuration of feature models. The models are drawn upon the
surface of the diagram. The diagram is placed in the central area of the Visual Studio main window.
Alongside the main window, there are many additional auxiliary windows (known as tool windows) that
can be repositioned freely.

Some of these graphical elements are of great relevance, and are explained in the next section.

GRAPHICAL ELEMENTS OF THE DESIGNER
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Figure 2: graphical elements of the feature designer
1. Toolbox

New features and feature groups can be added to the model by dragging the desired item from the
toolbox and dropping them on its parent. The toolbox is located in the upper left of the example figure.

The toolbox also allows the creation of model constraints, such as an Implies relationship and an
Excludes relationship.

2. Properties Grid

Each model element has a set of defined properties. Some of them can be modified, and for that
purpose, Visual Studio provides a properties grid where they can be set. Also, the name of a node can be
set directly in the corresponding shape in the diagram. In the figure, the properties grid is located in the
lower left corner.

The properties that are shown in the grid are dependent on the selected model element. For example, a
feature shares all the common properties of a node (such as Minimum and Maximum cardinalities), but
also, a feature has some exclusive modeling properties, such as type and value (see Figure 3).
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Figure 3: The properties grid for feature
3. Error Window

This window is usually placed in the lowest part of the main window. When the model is validated, this
window will output the validation errors present in the feature model.

The tool validates the model automatically after an external model has been imported, or after a model
has been loaded from disk. The model can also be validated manually at any time using the validation
entries placed in the diagram’s context menu.

4. Model Explorer

The feature explorer is a tree that shows a representation of the feature model in a concise, compact
way. It also provides a context menu where common operations can be performed on the nodes, such
as the insertion or deletion of new model nodes.
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Figure 4: Model Explorer with the provided context menu
5. Feature configurator

Like the Model explorer, this window offers a tree representation of the model. The key difference is
that the Feature configurator also provides the means to select or unselect the features that are
desired and will be included in a given configuration of the final product. In order to do this, the
configurator shows a checkbox next to each feature (note that feature groups cannot be configured).
Also, the configurator has a button that triggers the modification of the current the Visual Studio project
in order to reflect the configuration of the model.
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Figure 5: The Feature Configurator tool window

All of the previous graphical elements share a set of behaviour common to all the tool windows in Visual
Studio. In case a tool window gets hidden for any reason, it can be shown again using the right entries in
the View Menu. The tool windows corresponding to the Model Explorer and the Feature Configurator
can be found in the Other Windows submenu inside the View Menu.
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Figure 6: The View Menu showing entries for the tool windows

CREATION OF A NEW FEATURE MODEL

To start working with the tool and create a blank feature model, the first thing to do is to create a new
project in Visual Studio (File > New => Project).
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Select Visual C# as the project type in the tree, and choose the Feature Modeling Project template.
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Figure 7: Creating a new project
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Figure 8: Dialog which shows the Feature Modeling Project template

The template wizard lets you choose the type of Project which you wish to create. The dialog shows
standard Visual Studio projects which will have a new Feature designer added to them as a project item.
For the example, a Generic empty Project will be used.

. Feature Modeling Tool

Choose the type of project that you want to create
©) Windows Forms project
© Web project
() Windows Presentation Foundation project
(@) Console project

@ Genenic empty project

——

Figure 9: Template wizard for a new Feature Modeling project

LOADING AN EXISTING MODEL

To load an existing model, you have to open the Visual Studio project which contains the Feature model
item, the same way you would open any other project: (File = Open => Project/Solution).




ile | Edit View Tools Test Window Help

Open » | 2 Project/Solution... Ctrl+Shift+O
Close @5 | Web Site... Shift+Alt+0
Close Solution B3| File.. Ctrl+0

Save Selected tems  Ctrl+S Convert...

Save Selected Items As...
4 SaveAll Ctrl+Shift+S

Export Template...

cent Projects

! Product Lines DSL project01 Office Develc

Page Setup... Mon, 24 Nov 2(
Developers bui
Ctrl+P
Print... Ctr to keep up to d
Recent Files » videos, and bro
R and interact wi
Recent Projects 3

Microsoft Clo

Eri 7 Nowv 2000

Exit

Figure 10: Opening an existing project

Choose the desired project with the “.sIn” extension and Visual Studio will open it.
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Figure 11: Selecting the project to open

DESIGNING A FEATURE MODEL

The first node you add to the model will become the root of the model. Since the feature model is a
tree, there can only be a root, and it must be a feature node. To create the model, you can add as many
nodes to a parent node as you want.

e Creating a new feature

There are three equivalent ways to add a new child feature: by using the toolbox, the diagram’s context
menu, or the Model explorer’s context menu.

Figure 12 shows the toolbox. To use the toolbox to create a new feature, drag the feature item from the
toolbox and drop it on its parent node. Note that only the root feature can be dropped on the diagram.
The rest of the features must be dropped on the node which will serve as its parent in the tree.
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Figure 12: The Toolbox, with the Feature item selected

The second way to create a new feature is through the contextual menu of an existing node. To get
access to this menu, select the parent node and click with the right mouse button.

Add new Feature
Add new Feature Group
Cut
Copy
Paste
)( Delete
Validate
Walidate All
Properties

Save Selection as Image

Figure 13: Context menu of a model node in the diagram

Finally, a new feature can also be created from the context menu of the Model Explorer. This menu is
shown when you click with the right mouse button a node in the explorer. The selected tree node will
become the parent of the new feature.
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Delete Node

Figure 14: Context menu of the Model Explorer

A feature can be modeled as optional or mandatory, depending on the value of its minimal cardinality.

An optional feature has a minimal cardinality of zero, while a mandatory feature has a minimal
cardinality of one.

The graphical representation of a feature changes automatically to reflect its minimum cardinality. An
optional feature is represented with an empty circle:

10
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Figure 15: Graphical representation of an optional feature

A mandatory feature has a black-filled input circle:

e
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Figure 16: Graphical representation of a mandatory feature

L4 Creating a feature group

A feature group can only be created as a child of a feature. Except for that, the creation of a feature
group can be performed in the same ways as those of a feature.

Feature groups can be classified according to its cardinality.

e A XOR group has a <1,1> cardinality and has the following representation:

i4 XOR

Fegtuwre Grouwp <I-Ix

Figure 17: Graphical representation of a XOR group

e An OR group has a <1, k> cardinality, with k being the number of children of the feature group:

14 OR

Fegture Group <1-3»

Figurel8: Graphical representation of an OR group

MODEL CONSTRAINTS

You can define two kinds of constraints in the model. In both cases, these relationships can be created
only between two features (in other words, a feature group cannot participate in a constraint). One of
the features is named the source feature, and the other will be the target feature.

The first kind of constraint is known as an Implies relationship. When the source feature implies the
target feature, the selection of the source causes the automatic selection of the target.

To create this constraint, follow these steps:

1. Click the Implies item in the toolbox.
2. Click a feature on the diagram. This will be the source feature.



3. Click the target feature on the diagram, and the connection will be created.
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Figure 19: Toolbox with Implies constraint as the selected item

The constraint is depicted in the diagram as a dotted blue arrow, pointing from the source towards the
target.
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Figure 20: Implies constraint defined between two features

The second kind of constraint that can be defined is known as an Excludes constraint. When two
features participate in this constraint, the selection of one (it doesn’t matter which one) will unselect
the other feature in the configuration. The connection between the two features is made in the same
way as in the previous case, but now the order in which the features are selected to participate in the
relationship is irrelevant, because it does not matter which feature is the source and which is the target.

Once the constraint is created, a double-headed red arrow will link the two connected features in the
diagram.

o o
= A —

Feature [0.1] U Eeature 0.0

Figure 21: Excluded constraint defined between two features

MODEL VALIDATION

The tool lets you validate the model, or only a fragment. To validate the whole model, bring up the
diagram’s context menu and choose Validate All. To validate only a portion, first you have to select in
the diagram the elements that you want to validate, and choose Validate in the context menu.

12



Layout Diagram

Cut

Copy

Paste

Validate

Validate All

Import Model...

Export Model...
Properties

Save Diagram as Image

Figure 22: Context menu showing validation options

If any validation errors are found, they will be shown in the Error Window. When you double click on an
error listed, the tool will select in the diagram the offending elements to let you know at a glance which
elements are not valid.

While the model is in an invalid state, it cannot be configured. This is the reason why the Feature

Configurator is shown disabled in Figure 23.
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Figure 23: Validation errors are shown in the Error Window.

MODEL CONFIGURATION
The configuration is the process by which features are selected to be present in the final product.

Features can be selected from the Configurator tool window. If you want to select a feature, just mark
the checkbox next to it. To unselect a feature that you selected previously, unmark the associated
checkbox. The tool will propagate the changes you make and select or unselect automatically those
nodes that are affected by your actions. When a feature is automatically configured, the checkbox



appears grayed out, indicating that it cannot be changed manually. The tool also takes into account the
cardinality of the feature groups and the constraints that you may have defined.
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Figure 24: Configuring the model in the configurator tool window.

GENERATING THE PROJECT

Once you have configured the model to your desires, and only if the configuration is valid, the tool can
generate the corresponding project in Visual Studio. This can be done by activating the Generate Project
button in the Configurator tool window.

Generating a project means that: first, a base package is created for the root feature, which will serve as
the parent for the rest of the packages. Then, for every optional feature, a package is generated. The
package is physically created as a folder, both in the Visual Studio solution and in the file system. If the
folder already existed, its contents are not overwritten. The tool never performs destructive actions so
you don't risk losing data under any circumstances.

If the optional feature was selected in the configuration, then its associated package gets included in the
Visual Studio project, which means any code element that you create inside the generated folder will be
included in the build process. Otherwise, the folder is excluded from the project and any source code
belonging to its folder will not be included in the build.

Note: by default, Visual Studio does not show the items that are not included as part of the project. To
get Visual Studio to show the files, the IDE option Show All Files must be active. The tool automatically
toggles this button for you after a successful generation.

14



i Show Alll Files
™ References
- &) designer.pldsl

%) designer.pldsl.diagram

Figure 25 : The Visual Studio option for showing all files (“Show All Files”)
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Figure 26: Generated packages

EXPORTING THE MODEL

You can export the model to other formats tan can be imported later in another tool.

To export the model, choose the Export Model option found in the main context menu that is shown by
clicking with the right mouse button on the diagram’s surface.
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Figure 27: The Export Model option in the context menu

Then, choose an output format from the dropdown list in the dialog that appears.
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Figure 28: Choosing an output format in the Export model dialog

IMPORTING AN EXTERNAL MODEL

The tool also lets you import models that were created with other tools.

To begin the importing process, use the Import Model option from the context menu.
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Figure 29: The Import Model option in the context menu

Then, choose the desired output format from the choices that the dialog gives you.

IETY
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Figure 30: Choosing an input format in the Import model dialog

LAYING OUT THE DIAGRAM

The tool also lets you automatically rearrange the elements to form a tree, useful when the size of the
model grows and things become messy.

To do this, choose the Lay out Diagram option in the context menu.
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Figure 31: Lay out option in the context menu

You can zoom in or zoom out in the diagram by using two different shortcuts:
- Use CTRL + SHIFT + Left mouse button or CTRL + wheel-up to zoom in

- Use CTRL + SHIFT + Right mouse button or CTRL + wheel-down to zoom out
COPY, CUT AND PASTE

The model nodes can be copied and pasted from one node of the tree to another. This is useful to
quickly create a new subtree using an existing subtree as a template (using the copy command), or to
move a subtree across different parents (using the cut command)

To do this, you can use the standard commands in the Visual Studio’s Edit Menu, or in the main context
menu.
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Figure 32: Context menu showing the standard cut, copy, paste commands
To do this, follow these steps in order:

Select in the diagram the source node which you want to copy or cut
Activate the desired command (Cut or Copy). For example, to copy the selected subtree whose
parent is the selected node, you can either use choose the Copy command in the Edit menu,
the context menu of the selected node, or the keyboard shortcut (CTRL+C)

3. Select in the diagram the target node. This node will become the parent of the copied subtree.
Activate the Paste command

The tool will make sure that the whole sequence makes sense. For example, if the source root of the
subtree is a feature group, it will not allow it to be pasted with another group as the target, since
feature groups are not allowed to have a child group in the model.

SAVE DIAGRAM ELEMENTS AS AN IMAGE

The diagram can be exported as an image in Windows Metafile Format (WMF). You can also export a
selection instead of the whole model.

To export the whole tree, bring up the diagram’s context menu and choose “Save Diagram as Image”.

Layout Diagram
Cut

Copy

Paste

Validate
Validate All
Import Model...
Export Model...

= | Properties

Save Diagram as Image

Figure 33: Context menu, with the Save Diagram as Image item selected

To export only a selection, first select in the diagram the elements which you want to include in the
image, bring up the selection’s context menu, and choose “Save Selection as Image”.
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Figure 34: Context menu, with the Save Selected as Image item selected
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